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’//) U.S. Access Board — Identity & Mission

* Independent federal agency * Establish accessibility guidelines &
standards

e About 30 staff

* Governing Board * Provide technical assistance & training
» 13 Presidential appointees on these guidelines and standards

 ADA, Section 508, Section 255, Medical

* 12 Federal agency members Diagnostic Equipment

* Budget: over S9 million

— * Enforce the ABA Standards
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* Be a Coordinating body among federal
agencies

"

| |
1ll


Presenter Notes
Presentation Notes
Tim will ask questions here


What is “Section 508”7

)

e Section 508 of the Rehabilitation Act (29 U.S.C. § 794d), as amended by the Workforce
Investment Act of 1998 (P.L. 105-220) requires federal agencies to procure, develop,
maintain and use information and communication technology (ICT) that is accessible to
people with disabilities (PWD)

* Information and Communication Technology (ICT) -Information technology and other
equipment, systems, technologies, or processes, for which the principal function is the
creation, manipulation, storage, display, receipt, or transmission of electronic data and
information, as well as any associated content
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INFORMATION COMMUNICATION TECHNOLOGY




| Today’s Overview of Accessible ICT
//) - Why is it important? -

Applying Section 508:

e Accessible Content — websites, documents, services
* Resources

EO 14035: Diversity, Equity, Inclusion, and Accessibility
(DEIA)



) EO 14035: Diversity, Equity, Inclusion, and
) Accessibility (DEIA)

Purpose:

To promote Diversity, Equity, Inclusion, and Accessibility in the federal workforce
e Make the Federal Government a model employer of people with disabilities

eFederal workspaces - physical and digital - must be accessible (as required by the ABA and
Rehabilitation Act)

e Federal agencies must maximize accessibility to reduce the need for reasonable accommodations

e Government-wide DEIA Strategic Plan includes an “Accessibility Roadmap”

e All federal agencies must develop and maintain their own DEIA strategic plans



Accessibility Standards

e Section 508 of the Rehabilitation Act (2017)

e WCAG 2.0 Success Criteria and
Conformance Requirements (2008)

)




’//) Accessible ICT — What are the standards?

* Section 508 of the Rehabilitation Act (29 U.S.C. § 794d)
* Originally published 2000, Revised 2017, effective 2018

 WCAG 2.0 Success Criteria and Guidelines, Level A and AA (2008)

Applies to:

* ICT that is procured, developed, maintained, or used by federal
executive branch agencies

* Text of standards: www.access-board.gov/ict
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Presentation Notes
Characterize the language of 508 - Geared to a broad audience – varies from plain language to developer


Can an entity choose to
) follow Section 508 voluntarily ?

Yes, an entity may choose to provide accessible content, even if not required to do:

 Example 1: The Federal Reserve System reports to the legislative branch or
Congress, so they are NOT an executive branch agency. However, they DO
Have an accessibility policy to ensure that their website is accessible:
federalreserve.gov/accessibility.htm

 Example 2: Title |l (state and local governments) or Title Il (public
accommodations and commercial facilities) entities under the Americans with
Disabilities Act (ADA).



https://www.federalreserve.gov/accessibility.htm
https://www.ada.gov/regs2010/titleII_2010/titleII_2010_regulations.htm
https://www.ada.gov/regs2010/titleIII_2010/titleIII_2010_regulations.htm

’//) Section 508 Standards - Organization

Chapter 1 — Application and Administration

Chapter 2 — Scoping

Chapter 3 — Functional Performance Criteria (FPC)
Chapter 4 — Hardware

Chapter 5 — Software
Chapter 6 — Support Documentation and Services

Chapter 7 — Referenced Standards



) E103.4 Defined Terms
/ ) “ICT” and “IT”

ICT — (Information and Communication Technology)

Information technology and other equipment, systems, technologies,
or processes, for which the principal function is the creation,
manipulation, storage, display, receipt, or transmission of electronic
data and information, as well as any associated content.

Some Examples - computers and peripheral equipment; information
kiosks and transaction machines; telecommunications equipment;
software; applications; Web sites; videos; and, electronic documents.

IT (Information Technology) — same meaning as 40 U.S.C. 11101(6)
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Requirements for 508 ICT

wﬁ"‘ * Electronic Content

i//

* Support Documentation & Services




’//) Public Facing — external

Public Facing [E205.2]

* Content made available by an
agency to members of the general
public.

* Use: WCAG 2.0 Level A and AA
Success Criteria to make accessible
* Examples include:
e an agency Web site
* blog post, or
* social media pages
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Agency Official Communication —internal
) [205.3]

Categories:
A. An emergency notification;
B. An initial or final decision adjudicating an

administrative claim or proceeding;
C. An internal or external program or policy

announcement;
D. A notice of benefits, program eligibility,

employment opportunity, or personnel

action;
E. A formal acknowledgement of receipt;
F. A survey questionnaire;

Use WCAG 2.0 Level A and AA
G. A template or form; .
. - - Success Criteria

H. Educational or training materials; or

13

Intranet content designed as a Web page.
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Presentation Notes
OPM survey - =-  Employee Satisfaction  Survey

FEVS Federal Employee ViewPoint Survey “F-E-V-S”  by OPM federal viewpoint survey 

Max.gov 


Support Documentation and Services
) [Chapter 6]

e Documentation
e Ex: ICT admin and user manuals

e Explain accessibility and AT compatibility
features

e Use WCAG 2.0 Level A and AA Success
Criteria

* Services
* Ex: help desk, training services
* Accessibility and AT compatibility features
e Accommodation of communication needs

14



WCAG 2.0 Incorporated By Reference (IBR)

P
//) into Section 508

508
Standards

14



Web Content Accessibility Guidelines
) (WCAG) 2.0 -- Organization

R
« www.w3.org/TR/WCAG20

* 4 Principles [Perceivable, Operable, Understandable, Robust] - P O
UR
D
@,_o
e 12 Guidelines %
+* 38 Success Criteria (Requirements) ‘9.6/
> 25 SC at Level A @
» 13 SC at Level AA
A\Y
| | % &
o 24 SC at Level AAA (Not Required for Section % Qe
508/ADA — not counted) ’(9, (@)
)
. : . : 2
* Links to Hundreds of Techniques and Failures (Not Required) 0{96
Y.
e

16


http://www.w3.org/TR/WCAG20

E205.4: 38 WCAG 2 Level A & AA SC

Principle/Level Perceivable Operable Understandable Robust
Level A 1.1.1 Non-text Content 2.1.1 Keyboard 3.1.1 Language of Page 4.1.1 Parsing
1.2.1 Audio-only and Video- 2.1.2 N o Keyboard Trap 3.2.1 On Focus 4.1.2 Name, Role, Value
only (Pre.) o i
2.2.1 Timing Adjustable 3.2.2 On Input
1.2.2 Captions (Pre.) ] L
2.2.2 Pause, Stop, Hide 3.3.1 Error Identification
1.2.3 Audio Description or .
Media Alternative (Pre.) 2.3.1 Three Flashes or Below | 3.3.2 Labels or Instructions
Threshold
1.3.1 Info and Relationships
2.4.1 Bypass Blocks
1.3.2 Meaningful Sequence .
2.4.2 Page Titled
1.3.3 Sensory Characteristics
2.4.3 Focus Order
1.4.1 Use of Color
2.4.4 Link Purpose (In
1.4.2 Audio Control Context)
Level AA 1.2.4 Captions (Live) 2.4.5 Multiple Ways 3.1.2 Language of Parts (Note: There are NO Robust
1.2.5 Audio Description (Pre.) | 2.4.6 Headings and Labels | 3.2.3 Consistent Navigation | >¢° 7t Level AA)
1.4.3 Contrast (Minimum) 2.4.7 Focus Visible 3.2.4 Consistent Identification
1.4.4 Resize text 3.3.3 Error Suggestion
17

1.4.5 Images of Text

3.3.4 Error Prevention (Legal,
Financial, Data)




Accessible content

’ WCAG 2.0 SC & 508
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’/) Document Accessibility

WCAG 2.0 Success Criteria
help to make a document

|

: K

accessible - .

Example: - £~
= i

Use of color contrast - =
H B [

SC 1.4.3 Contrast (Minimum)

19



’//) SC 1.4.3 Contrast (Minimum)

“The visual presentation of text and images of text has
a contrast ratio of at least 4.5:1 ...” (Level AA)

20



Problems: color contrast

) ————————————

» Examples of why a specific numerical value is important:

Sentence with Color Contrast Sentence without color contrast
Does this text contrast with the Does this text contrast with the
? white background?

One common problem is that typical | One common problem is that typical
red text on white background is hard |red text on white background is hard
to read but is not prohibited. to read but is not prohibited.

Darker red still catches the eye while being much better for many people
with low vision. 21



Sample tool — Color Contrast Analyzer (CCA)

Foreground colour (black)

Background colour

#FFFFFF

v Sample preview

example text showing contrast

WCAG 2.1results Contrast ratio
211

» 1.4.3 Contrast (Minimum) (AA)

(¥) Pass (regular text) (¥) Pass (large text)
» 1.4.6 Contrast (Enhanced) (AAA)

(¥) Pass (regular text) (¥) Pass (large text)
» 1.4.11 Non-text Contrast (AA)

@ Pass (Ul components and graphical objects)
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Presentation Notes
SC 1.4.3 links to Techniques for the tools


Creating Accessible Documents

* WORD -image with alternative text
* PDF - tag tree structure
* Presentations —Slide layout reading order

)




gful image with alternative text

’/ WORD — a meanin

Format.Ricture

~ - i
< q LA ) B -~
~ -
e ﬁ Text Bok L I
= Y w ¥ . 4 Alt ch:.n
’ Q I\ Paste Options
o & 2 0 O
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Presenter Notes
Presentation Notes
Alt text is visible to AT screen reader


Alt text for a decorative image

)

* Instruction: Select an image or object that is just for decoration, “right click (or
Shift+F10)>Format Picture

e (Note: could say Format Object, Format Shape, etc.)>Layout & Properties
icon>Alt Text,” and read the “Description” field.

* Test: Does the “Description” field of decorative image or objects contain blank
spaces between quotes? If not, the document fails this test.

* Decorative Content — alternative text using “quote space space quote.”

25



’ Decorative Content — alternative text using
// “guote - space - space - quote.”

26



PDF Terminology
) “PDF”= Portable Document Format

* WHAT: Electronic document file type -that can be viewed, printed, and electronically
submitted.

* THREE key components:

1. Physical view - which is the physical representation of text and graphics aka “Print
View.”

2. Content view - which is the layer of the PDF where the actual document content
resides.

3. Tags Structure Tree - which establishes the PDF
content structure and logical reading order.

27
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Structure: Tags Structure Tree of a PDF

)

» Establishes the PDF content structure and logical reading order for assistive
technology.

 Displays tags used e.g. Headers <H>, Paragraphs <P>, Lists <List>, and Tables
<Table>.

* To view the Tags Structure Tree, access the Tags Pane by selecting the View
menu and then selecting Show/Hide > Navigational Panes > Tags.

» Selecting the arrow symbol to the left of the tag, will expand the tag and its child
element, which is the content on the page with which the tag is associated.

28



Accessing the Tags Structure Tree of a PDF

i m Window Help

V ° ° ° ° Rotate View »
Page Navigation LS i N ; J [
iew > Show/Hide > Navigation . i A B OO en- BT S
| Page Display »
Panes > Tags '
g .
Tools ; Acrobat Practice
(S'no-.-.-_r’Hide ) (“dauigation Panes ’) Ul Articles
Display Theme " v Tools Pane Shift+F4 @ Attachments
Toolbar Items » u Bookmarks
lz‘ Read Mode Ctrl+H
Page Controls » D Content
Full Screen Mode Ctrl+L
E] v Menu Bar F9 Destinations

E‘F Tracker... @ Layers

Button Labels

o
B Model Tree
Read Out Loud E Rulers & Grids ’ o

https://webaim.org/techniques/acrobat/acrobat 22 Order

Compare Files Cursor Coordinates
@ Page Thumbnails

t,’-§' Signatures

®
‘ Show Navigation Pane F4

Reset Panes
Adohe




Example of a Tags Structure Tree in a document

®

Options =

B E‘ Tags
= ﬂ <Sects

stz

1
w4 <Ha Heading Level 1
4 <p> . . . .
o < Heading level one is reserved for the main title of a document
g« .
q <> eading Level 2
D8 <Table> Are like chapter titles of a book. they are the main headings for sections of a document.
B o <TBody =
E-EH <TR . .
= <THo 8 s Tistitem
B «T e Listitem
EHEH <TR> ¢ Listitem
84 =D i
wE 8
B (P e "Column Header Column Header
& <Fiqure ~Data Data

’ i
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Presentation: Text Formatting:
Does the reading order match the visual layout?

How to test:

* Open the Selection pane:
(“Home tab > Drawing > Arrange>Selection Pane”).

* The first object on the slide will display at the bottom of the Selection Pane.
* Starting from the bottom and moving to the top, select each object to view the reading
order on the slide.

* Test: Does the selection of each object match the visual reading order of the slide? If
not, the document fails this test.

* Figure: Example of selected and subsequent objects matching the slide layout reading
order

31



Example of selected and subsequent objects
matching the slide layout reading order

View ACROBAT  Format Q Tell me what you want to do...

Insert  Design  Transitions  Animations  Slide Show  Review
=) [ LayoTr : Bl e = I~ |Em\\OOo DD | ), & Shape Fill -
patD [“ : N— £ Reset - DALL O] Q“k Z Shape Outlin
ste ew AV« Aa . = = =] =, ~A rrange | Quic
- ¥ glige~ & Section~ T'USeel-Ra- &~ = STE=Smm i = ol RSN Wleg-aShape Elisch
Clipboard & Slides Font r Paragraph ] Drawing | Order Objects
Selection v x | ™ Bring to Front
€ Show All | Hide Al -l DD Send to Back
O, ~ SUbtlﬂE‘ 2 L ] Brfng Eorw-ard
tAccessible Elecyronic Document’ m,ﬂ oy
p,m,n_4 ~ |/"0 Send Backward
e
Group Objects

KED COF —~

Commun:tv Of Practice

PowerPoint Checklist e

Basic Testing and Authoring Guide -
& Align
?k Rotate

E[;— Selection Pane...

32






Resources - Standards

b

e www.Access-board.gov — Access Board website
* Section 508 Standards & ICT Testing Baseline

 www.w3.org/TR/WCAG20/ WCAG 2.0 materials

* www.Section508.gov —FAQs, Best Practices - accessible
documents , Acquisitions, 508 PM contact list




508 Resources — Practice information

)

* Bimonthly Section 508 Best Practices Webinar Series

 www.accessibilityonline.org/cioc-508

* “ICT Guidance for Implementing Accessibility into DEIA Plans in the Federal
Workforce” July 26t

* Archives (www.accessibilityonline.org/cioc-508/archives/)

e Testing for Web

* Trusted Tester (www.dhs.gov/trusted-tester)
* |ICT Testing Baseline for Web (ictbaseline.access-board.gov)

35


http://www.accessibilityonline.org/cioc-508/archives/

Accessible WORD, PDF and
Presentations

* https://www.section508.gov/create/documents

* https://www.section508.gov/create/pdfs/authoring-guides/

* https://www.section508.gov/create/presentations/authoring-

guides/

36


https://www.section508.gov/create/documents
https://www.section508.gov/create/pdfs/authoring-guides/
https://www.section508.gov/create/presentations/authoring-guides/
https://www.section508.gov/create/presentations/authoring-guides/

'//) U.S. Access Board

E-mail: 508@access-board.gov
ta@access-board.gov

www.access-board.gov
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